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Accessories

User Replaceable Parts

Ink Cartridges

Printer Specifications

Printing

Printing method On-demand ink jet

Nozzle configuration

black 192 nozzles 
color 288 nozzles (96 each cyan, magenta, 

yellow)

Resolution Maximum 2880 × 720 dpi

Input buffer 256KB

Print direction Bidirectional with logic seeking

Control code ESC/P2™ and raster graphics code, 
EPSON Remote, and IBM® X24E 
emulation code

Character tables 1 italic and 12 graphics character tables

Character sets 14 international character sets and 1 legal 
character set

Mechanical 

Paper feed 
method Friction with auto sheet feeder, rear entry

Sheet feeder 
capacity Maximum 100 sheets of 17 lb (64 g/m2) 

paper

Dimensions

Storage Width: 18.4 inches (467 mm) 
Depth: 11.7 inches (297 mm) 
Height: 7.8 inches (199 mm)

Printing Width: 18.4 inches (467 mm) 
Depth: 23.4 inches (594 mm)
Height: 12.8 inches (325 mm)

Weight 18.5 lb (8.4 kg) without the ink cartridges

Electrical

* Also designed for IT power systems with Phase to Phase voltage 
220–240 V

Part name Part number

Paper support assembly 1040662

Printer cover assembly 1056463

Logo plate 1058403

Cartridge Part number

Black T003011

Color T005011

ink cartridge 
clamps

thickness lever

control panel

sheet feeder

left edge 
guide

output tray 
extensions

output 
tray

printer 
cover

paper support

right edge guide

Specification 120 V Model 240 V Model*

Input voltage range 99 to 132 V 198 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.7 A 0.4 A 

Power consumption Approx. 30 W (ISO/IEC 10561 Letter 
Pattern)
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Ink Cartridges

* The print capacity may vary depending on how often you clean the 
print head and use the printer.

** The ink thaws and is usable after approximately 3 hours at 77 °F 
(25 °C).

To ensure good results, use genuine EPSON cartridges 
and do not refill them. Other products may cause 
damage to your printer not covered by EPSON’s 
warranty.

Do not use an ink cartridge after the expiration date on 
the package. 

Environmental

Temperature

Operation 50 to 95 °F (10 to 35 °C)

Storage −4 to 140 °F (−20 to 60 °C) 
1 month at 104 °F (40 °C) 

Transit* –4 to 140 °F (–20 to 60 °C) 
120 hours at 140 °F (60 °C)

Humidity (without condensation)

Operation 20 to 80% RH

Storage* 5 to 85% RH

*Stored in shipping container

Safety Approvals

Safety standards UL 1950 with D3, CSA C22.2 No. 950

EMC FCC part 15 subpart B class B

Interfaces

Parallel interface
Forward channel

Reverse channel

USB interface

Specification

Black ink cartridge 

(T003011)

Color ink cartridge 

(T005011)

Color(s) Black Cyan, magenta, and 
yellow

Print capacity* 1200 pages (A4, ISO/IEC 
10561 letter pattern); 
840 pages at 5% 
coverage at 360 dpi)

570 pages (A4, 5% 
coverage at 360 dpi)

Cartridge life 2 years from production date and up to within 
6 months after opening package at 77 °F (25 °C)

Storage 
temperature

–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Transit 
temperature

–22 to 140 °F (–30 to 60 °C)
1 month at 104 °F (40 °C)
120 hours at 140 °F (60 °C)

Freezing 
temperature**

3.2 °F (–16 °C) –0.4 °F (–18 °C)

Dimensions 1.1 (W) × 2.6 (D) × 1.6 (H) 
inches
28.9 (W) × 67.4 (D) × 
41.8 (H) mm

2.1 (W) × 2.7 (D) × 1.6 (H) 
inches
54.0 (W) × 67.4 (D) × 
41.8 (H) mm

Specification Description

Data format 8-bit parallel, IEEE-1284 compatibility mode

Synchronization STROBE pulse

Handshake timing BUSY and ACKNLG signals

Signal level TTL compatible

Connector 57-30360 Amphenol connector or equivalent

Specification Description

Transmission mode IEEE-1284 Nibble mode

Adaptable connector 57-30360 Amphenol connector or equivalent

Synchronization Refer to the IEEE-1284 specification

Handshaking Refer to the IEEE-1284 specification

Signal level IEEE-1284 Level 1 device

Data transmission timing Refer to the IEEE-1284 specification

Specification Description

Standard Based on Universal Serial Bus Specifications 
Revision 1.0, Universal Serial Bus Device Class 
Definition for Printing Devices Version 1.0

Bit rate 12 Mbps (full speed device)

Data encoding NRZI

Adaptable connector USB Series B

Recommended cable 
length

6.5 feet (2.0 meters)
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Paper

* Premium Glossy Photo Paper is not designed for this printer, and 
will not retain its lightfastness when used with this printer.

Notes:
Print only under these conditions:
Temperature: 59 to 77 °F (15 to 25 °C)
Humidity: 40 to 60% RH

Store glossy film and self adhesive sheets under these conditions:
Temperature: 59 to 86 °F (15 to 30 °C)
Humidity: 20 to 60% RH

Since the quality of any particular brand or type of paper may be 
changed by the manufacturer at any time, EPSON cannot guarantee 
the use of any particular brand or type of paper. Always test samples 
of paper stock before purchasing large quantities or printing
large jobs. 

Poor quality paper may reduce print quality and cause paper jams and 
other problems. If you encounter problems, switch to a higher grade 
of paper. Do not load curled or folded paper, envelopes, or 
transparencies.

Paper type Size Paper types Thickness Weight

Single sheets Letter (8.5 × 11 inches) 
A4 (210 × 297 mm)
A5 (148 × 210 mm)
B5 (182 × 257 mm)
Legal (8.5 × 14 inches) 
Half letter (5.5 × 8.5 inches)
Executive (7.5 × 10 inches)

Plain paper, bond paper, 
and special ink jet papers 
distributed by EPSON

0.003 to 0.004 inch 
(0.08 to 0.11 mm) 

17 to 24 lb 
(64 to 90 g/m2) 

Transparencies and 
glossy film

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
A6 (105 × 148 mm, glossy film only)

Transparencies and glossy 
film distributed by EPSON

— —

Photo Paper 4 × 6 inches (102 × 152 mm)
Letter (8.5 × 11 inches)
A4 (210 × 297 mm)
Panoramic (8.27 × 23.4 inches, 210 × 594 mm)

Photo Paper distributed by 
EPSON

— —

Glossy Photo Paper* Letter (8.5 × 11 inches) 
A4 (210 × 297 mm)

Premium Glossy Photo 
Paper distributed by EPSON

— —

Matte Paper - 
Heavyweight

Letter (8.5 × 11 inches)
A4 (210 × 297 mm)

Matte Paper distributed by 
EPSON

— —

Photo stickers A6 (105 × 148 mm) with 4 or 16 frames Photo stickers distributed 
by EPSON

— —

Self adhesive sheets 
and iron-on cool peel 
transfer paper 

A4 (210 × 297 mm)
Letter (8.5 × 11 inches; Iron-on Cool Peel 

Transfer Paper only)

Self adhesive sheets and 
Iron-on Cool Peel Transfer 
Paper distributed by EPSON

— —

Envelopes #10 9.5 × 4.1 inches (240 × 104 mm) 
DL 8.7 × 4.3 inches (220 × 110 mm) 
C6 4.4 × 6.4 inches (114 × 162 mm)
Note card envelope 5.2 × 8.7 inches (132 × 220 mm)

Plain, bond, or 
air mail paper

0.006 to 0.02 inch 
(0.16 to 0.52 mm)

12 to 20 lb 
(45 to 75 g/m2)

Cards A6 (105 × 148 mm)
5 × 8 inches (127 × 203 mm)

Ink jet cards and note cards 
distributed by EPSON

— —
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Printable Area

A The minimum top margin is 0.12 inch (3.0 mm).
When printing multiple sheets of EPSON Photo Quality Glossy 
Film, the minimum top margin is 1.2 inches (30 mm).

BL The minimum left margin is 0.12 inch (3.0 mm).
BR The minimum right margin is:

0.35 inch (9.0 mm) for letter and legal
1.10 inches (28 mm) for #10 envelopes
0.28 inch (7 mm) for DL envelopes
0.12 inch (3.0 mm) for all other paper sizes and C6 envelopes.

C1 The minimum bottom margin is 0.55 inch (14.0 mm) using the 
Standard printable area setting. 

C2 The minimum bottom margin can be decreased to 
0.12 inch (3.0 mm) using the Maximum printable area setting. 
However, the print quality in the expanded printable area may be 
reduced.

Note:
Always load paper into the sheet feeder short edge first except 
envelopes. Load envelopes long edge first.

Media

* EPSON Premium Glossy Photo Paper is not designed to be used 
with this printer, and will not retain its lightfastness when used with 
this printer.

A

BL BR

C1

A

BR
C1

BL

Envelopes

Single sheets 
and cards

C2

Paper name Size Part number

EPSON 360 dpi Ink Jet 
Paper

Letter
A4 (8.3 x 11.7 inches)

S041060
S041059

EPSON High Quality Ink 
Jet Paper

Letter
A4 (8.3 x 11.7 inches)

S041111
S041117

EPSON Photo Quality Ink 
Jet Paper

Letter
A4 (8.3 x 11.7 inches)
Legal

S041062
S041061
S041067

EPSON Photo Quality Ink 
Jet Cards

A6 (4.1 x 5.8 inches) S041054

EPSON Photo Paper 4 x 6 inches
Letter
A4 (8.3 x 11.7 inches)
Panoramic (8.3 x 23 inches)

S041134
S041141
S041140
S041145

EPSON Photo Stickers 
Kit (CD-ROM/paper)
EPSON Photo Stickers 
(refill)

A6 (4.1 x 5.8 inches)

A6 (4.1 x 5.8 inches)

S041144-KIT

S041144

EPSON Photo Quality 
Glossy Film

Letter
A4 (8.3 x 11.7 inches)
A6 (4.1 x 5.8 inches)

S041072
S041071
S041107

EPSON Ink Jet 
Transparencies

Letter
A4 (8.3 x 11.7 inches)

S041064
S041063

EPSON Photo Quality 
Self Adhesive Sheets

A4 (8.3 x 11.7 inches) S041106

EPSON Iron-On Cool Peel 
Transfer Paper 
(10 sheets/50 sheets)

Letter S041153/
S041155

EPSON Photo Quality 
Glossy Paper

Letter
A4 (8.3 x 11.7 inches)

S041124
S041126

EPSON Matte Paper – 
Heavyweight

Letter S041257

EPSON Premium Glossy 
Photo Paper*

Letter
A4 (8.3 x 11.7 inches)

S041286
S041285
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Control Panel

The four lights on your printer’s control panel show the 
printer’s status and alert you to problems like paper jams. 

Installing an Ink Cartridge for the First 
Time

1. Plug the power cord into a grounded outlet.

Don’t use an outlet controlled by a wall switch or timer, 
or one that uses the same circuit as a large appliance. 
This may disrupt the power, which can erase the 
printer’s memory or damage its power supply.

2. Lower the output tray and open the printer cover.

3. Press the 

 

P power button to turn on the printer. The 

 

P power light flashes, the 

 

B black and 

 

A color ink out 
lights come on, and the black ink cartridge holder moves 
slightly left to the installation position.

Always use the 

 

P power button to turn the printer on or 
off. Never use an external switch, such as on a power 
strip.

4. Remove the ink cartridges from their foil packages. Then 
pull off only the yellow part of the tape seal on the top of 
each cartridge. It is okay if a bit of the yellow tape remains 
on the cartridge. Don’t pull off the blue part.

You must remove the yellow tape seal from the top of 
the cartridge or you will permanently damage it. Don’t 
remove the tape seal from the bottom.
 

If ink gets on your hands, wash them thoroughly with 
soap and water. If ink gets in your eyes, flush them 
immediately with water.

5. Lift up the black ink cartridge clamp. 

 

P is on The 

 

P power light is on when the printer is ready to print. It 
flashes when the printer is receiving a print job or 
performing maintenance (i.e., cleaning the print head).

 

S flashes When the 

 

S paper out light flashes, you have a paper jam. 
Press the 

 

E load/eject button to try to clear the jam. If that 
doesn’t work, turn off the printer and gently pull the paper 
forward (toward the output tray). Make sure none of the 
sheets are curled, creased, old, stuck together, or too thin. 
Then reload the stack against the right edge guide and slide 
the left edge guide over to the paper’s left edge. Then turn 
the printer on.

 

S is on When the 

 

S paper out light comes on, your paper is out or 
incorrectly loaded. Make sure none of the sheets are curled, 
creased, old, stuck together, or too thin. Then reload the 
stack against the right edge guide and slide the left edge 
guide over to the paper’s left edge. Press the 

 

E load/eject 
button to resume printing.

 

B or 

 

A 
flash

When an ink out light flashes, your ink supply is low. Make 
sure you have a replacement cartridge.

 

B or 

 

A 
are on

When an ink out light comes on, replace the ink cartridge. 
See page 8 for instructions. If it comes on after you’ve 
replaced a cartridge, you’ve installed the wrong cartridge.

 

P and 

 

S 
flash, 
and

 

B and 

 

A 
are on

When the 

 

P power and 

 

S paper out lights flash and the 

 

B black and 

 

A color ink out lights come on, jammed paper 
may be blocking movement of the print head. Turn off the 
printer, wait a few seconds, and turn it back on. If no paper 
ejects, turn off the printer, remove the jammed paper, and 
turn it on again. If the lights still flash or stay on, contact 
your dealer or EPSON.

 

P S B A 
flash

When all the lights flash, your printer may have an internal 
error. Make sure you removed all the packing material as 
described on the Start Here poster. Then turn off the 
printer, wait a few seconds, and turn it on again. If the lights 
still flash or stay on, contact your dealer or EPSON.

 

P S B A 
are off

When all the lights are off, the printer is not receiving 
power. Try these solutions:
❏ Make sure the printer is turned on.
❏ Turn off the printer, plug in the power cord securely,

and turn on the printer again.
❏ Make sure the outlet works and is not controlled by a
 switch or timer.

power button

load/eject button

cleaning button

paper out light

color ink 
out light

black ink 
out light

power 
light

black cartridge color cartridge

Remove the yellow tape 
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6. Place the black ink cartridge in its holder with the label 
facing up and toward the back of the printer. Then press 
down the clamp until it locks into place.

7. Press the 

 

R cleaning button to move the color ink cartridge 
holder into the installation position.

If the print head doesn’t move to the color ink cartridge 
installation position, hold down the cleaning button for 
three seconds until the print head moves to the color ink 
cartridge installation position.

8. Repeat steps 5 and 6 to install the color ink cartridge.

9. Press the 

 

R cleaning button to begin charging the ink 
delivery system, and then close the printer cover.

Charging takes about two minutes. The 

 

P power light flashes, 
and the printer makes various sounds until it is finished. 
Don’t turn off the printer or interrupt the charging process or 
it will start over and you’ll use more ink than necessary. 
Charging is complete when the 

 

P power light stops flashing 
and stays on.

Never turn off the printer when the 

 

P power light is 
flashing, unless the printer hasn’t moved or made any 
noise for more than five minutes.

Testing the Printer

You can run a printer check to determine whether the 
problem comes from the printer itself or some other source. 
Follow these steps to run the printer check:

1. Make sure both the printer and computer are turned off.

2. Disconnect the interface cable from the printer.

3. Make sure paper is loaded in the printer.

Load paper that’s at least 8.27 inches (210 mm) wide. 
This prevents ink from spraying inside the printer and 
smudging your printouts.

4. Hold down the 

 

E load/eject button, then press and release 
the 

 

Ppower button. Continue holding down the 

 

E load/
eject button until the 

 

Ppower light starts to flash, then 
release it.

The printer prints one page showing its ROM version 
number, ink counter, and a nozzle check pattern in black, 
magenta, cyan, and yellow. Only the nozzle check pattern is 
shown below.

5. To end the check, turn off the printer after it prints the 
check page. Then reconnect the interface cable and turn on 
your printer and computer.

❏ If the check page prints, the problem lies in your 
software settings, the interface cable, or your computer. 
Or your printer or application software may not be 
installed correctly.

❏ If the check page does not print correctly, you may have 
a problem with your printer. First try cleaning the print 
head (see page 10). Then try the suggestions in 
“Problems and Solutions” in the Printer Basics book or 
“Troubleshooting” in the electronic EPSON Stylus 
COLOR 980 Reference Guide.
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Printing on Special Media

Whether you print on plain paper or special media, you need 
to make sure you select the correct Media Type setting in the 
printer software, as shown in the following table.

* Use the Flip Horizontal option to reverse your image before you 
print it—especially if it includes text—so the image will appear 
correctly when it’s transferred.

** EPSON Premium Glossy Photo Paper is not designed to be used 
with this printer, and will not retain its lightfastness when used 
with this printer.

Media Loading and Handling Guidelines

Don’t use any cleaning sheets included with special 
media; they may jam inside the printer.

The type of paper or other media you use is one of the most 
important factors in determining the quality of your printed 
output. The following tips will help you get the best results on 
any type of paper or other media:

❏ Always handle sheets by the edges, and don’t touch the 
printable surface.

❏ Be sure to load the printable (whiter or glossier) side of the 
media face up in the sheet feeder. 

❏ Load paper only up to the arrow mark on the left edge 
guide.

❏ Remember to select the correct Media Type and Paper Size 
for your paper.

❏ If the special media has protective sheets between the sheets 
of media, be sure to remove the protective sheets before 
printing. After printing, cover the printed side of your 
media with these sheets before storing.

❏ Use ink jet papers within one year of purchase. Use glossy 
film and transparencies within six months. Return unused 
sheets and envelopes to their original packages as soon as 
possible. See “Paper” on page 3 for more media storage 
information.

❏ Set the thickness lever to the + position when you print on 
envelopes or if ink smears when you print on other thick 
media. Open the printer cover and position the lever as 
shown below. Then close the cover and print. (Make sure 
you return the lever to the 0 position before you print on 
regular media.)

For this media name...

Then select this Media 

Type setting in your 

printer software...

Plain paper, letter size Plain paper

Envelopes

EPSON 360 dpi Ink Jet Paper 360 dpi Ink Jet Paper

EPSON Iron-On Cool Peel Transfer 
Paper*

EPSON High Quality Ink Jet Paper Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Paper

EPSON Photo Quality Ink Jet Cards 

EPSON Photo Quality Self Adhesive 
Sheets

EPSON Matte Paper – Heavyweight Matte Paper – Heavyweight

EPSON Photo Paper
EPSON Photo Quality Glossy Paper

Photo Paper

EPSON Premium Glossy Photo Paper Premium Glossy Photo 
Paper

EPSON Photo Quality Glossy Film** Photo Quality Glossy Film

EPSON Photo Stickers 

EPSON Ink Jet Transparencies Ink Jet Transparencies 

Media Guidelines

Envelopes Up to 10 envelopes. Set the paper 
thickness lever to the + position.

EPSON 360 dpi Ink Jet Paper 
and Photo Quality Ink Jet 
Paper

Up to the arrow mark on the left edge 
guide.

EPSON Photo Quality Ink Jet 
Cards

Up to 30 cards. Always place the 
support sheet* included in your Media 
Pack under the cards.

EPSON Photo Quality Glossy 
Film

One sheet at a time, or a maximum of 
20 sheets. When loading multiple 
sheets, set the minimum top margin of 
the page to 1.2 inches. Always put a 
support sheet* or a sheet of plain 
paper under the glossy film.

EPSON Ink Jet 
Transparencies

Up to 30 transparencies. Always put a 
sheet of plain paper under the stack of 
transparencies.

setting for regular 
paper

setting for 
envelopes and 
thick paper
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* Don’t print on support sheets that are loaded under special media.

** EPSON Premium Glossy Photo Paper is not designed to be used 
with this printer, and will not retain its lightfastness when used 
with this printer.

Printing on Both Sides of the Paper

This section includes instructions for standard double-sided 
printing. For inofrmation about how to create single-fold 
booklets, see your electronic Reference Guide.

Follow these steps to print on both sides of the page:

1. Load plain paper or another double-sided media in your 
printer. You can print up to 60 pages at a time on 30 sheets 
of paper.

2. Windows: Select File > Print.  When the EPSON Stylus 
COLOR Properties dialog box appears, click the Layout tab 
and choose Double-Sided Printing.

Macintosh: Select File > Page Setup. Then click Double-
Sided Printing in the Page Setup dialog box.

3. Click OK to save your settings.

4. Start printing.

Windows: Click OK on your application’s Print dialog box.

Macintosh: Select File > Print, then click Print on the 
printer settings dialog box.

The printer prints all the odd-numbered pages, starting 
with page 1. When all of the odd-numbered pages have 
printed, you see an alert on your screen telling you to reload 
the paper.

5. Take the entire stack that you have printed and, without 
changing the order of the pages, reload the paper printed 
side down, the the top edge first.

6. Click Resume on the alert window. The printer prints the 
even-numbered pages.

If you’re printing a document that is longer than 60 pages, 
you’ll need to print it in sections. For example, if you were 
printing a 175-page document, you would print it in three 
sections of 30, 30, and 28 sheets of paper. 

If you’re printing a document with an odd number of 

pages, make sure you print even numbers of pages for the 

first sections and an odd number of pages for the last 

section. That way, if you have a blank page, it will appear at 

the end of your document.

Removing Jammed Paper

When the 

 

S paper out light flashes, you have a paper jam. 
Press the 

 

E load/eject button to try to clear the jam. If that 
doesn’t work, turn off the printer and gently pull the paper 
forward (toward the output tray) to pull it out. Don’t pull the 
paper backward (toward the paper support). Make sure none 
of the sheets are curled, creased, old, stuck together, or too 
thin. Then reload the paper against the right edge guide and 
slide the left edge guide against it. Turn on the printer and 
press the 

 

E load/eject button to resume printing.

Replacing an Ink Cartridge

When the 

 

B black or 

 

A color ink out light flashes, the 
indicated cartridge is low on ink. This is a good time to make 
sure you have a new cartridge. When the light stays on, the 
cartridge is empty and you need to replace it. You cannot 
print if either ink cartridge is empty.

To check the level of ink you have left, see the graphic in the 
printer driver Properties window (Windows); or click the  
ink level icon in the main printer settings dialog box for your 
application, or in the EPSON Monitor 3 utility (Macintosh).

Use these EPSON ink cartridges within six months of 
installing them and before the expiration date on the package:

❏ Black ink cartridge T003011

❏ Color ink cartridge T005011

To ensure good results, use genuine EPSON ink cartridges 
and do not refill them. Other products may cause damage 
to your printer not covered by EPSON’s warranty.

When you need new ink cartridges, contact your dealer or call 
the EPSON Store™ at (800) 873-7766 (U.S. sales only). Or 
visit the EPSON Store at www.epson.com (U.S. sales only). In 
Canada, please call (800) 873-7766 for dealer referral.

If you need to replace an ink cartridge before the lights flash 
(because the ink is too old, for example), see the instructions 
in “Replacing an Outdated Ink Cartridge” on page 9.

EPSON Photo Quality Self-
Adhesive Sheets and Iron-On 
Cool Peel Transfer Paper

One sheet at a time

EPSON Photo Stickers One sheet at a time

EPSON Photo Paper Up to 20 sheets. Always put a support 
sheet* under the stack of Photo Paper.

EPSON Matte Paper – 
Heavyweight

Up to 20 sheets. Always put a 
support sheet* under the stack of 
Matte Paper – Heavyweight.

EPSON Premium Glossy 
Photo Paper**

One sheet at a time.

Media Guidelines
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Removing and Installing Ink Cartridges

You can replace a cartridge when the 

 

B black or 

 

A color ink 
out light is either flashing or on. (If you perform these steps 
when both ink out lights are off, the printer cleans the print 
heads as described on page 10.)

Follow these steps to replace an ink cartridge when its ink out 
light is on:

1. Make sure the printer is turned on and not printing, then 
open the printer cover.

2. Press the 

 

R cleaning button and hold it for about three 
seconds until the print head moves left and the 

 

P power 
light begins flashing. The print head moves to the black or 
color cartridge replacement position, depending on which 
ink cartridge is empty.

To avoid damaging the printer, never move the print head 
by hand. Don’t open the clamp or remove a cartridge 
except to replace it with a new one. Once you remove a 
cartridge, you can’t reuse it, even if it contains ink.

3. Remove the new ink cartridge from its packaging. 

4. Remove only the yellow part of the tape seal on top as 
shown to the right. Don’t pull off the blue portion or try to 
remove the clear seal underneath the cartridge.

You must remove the yellow tape from the top of the 
cartridge or you will permanently damage it. Do not 
remove the clear seal from the bottom of the cartridge; 
ink will leak.

5. Pull up the ink cartridge clamp. The cartridge rises up from 
its holder.

6. Lift the cartridge out of the printer and dispose of it 
carefully. 

If ink gets on your hands, wash them thoroughly with 
soap and water. If ink gets into your eyes, flush them 
immediately with water.

7. Lower the new ink cartridge into its holder with the label 
facing up and toward the back of the printer.

8. Press down the ink cartridge clamp until it locks in place.

9. If you need to replace the other ink cartridge, repeat steps 2 
through 8 before continuing with step 10.

10. Press the 

 

R cleaning button and close the printer cover. 
The printer moves the print head and begins charging the 
ink delivery system.

The 

 

P power light flashes, and the printer makes various 
sounds. Charging takes about one minute. When it’s finished, 
the 

 

Ppower light stops flashing and stays on.

Never turn off the printer while the 

 

P power light is 
flashing, unless the printer hasn’t moved or made noise 
for more than 5 minutes.

Replacing an Outdated Ink Cartridge

If an ink cartridge is more than six months old, you may need 
to replace it. You may notice that your printouts don’t look as 
good as they used to. If print quality doesn’t improve after 
cleaning and aligning the print head, you can replace one or 
both cartridges.

Follow these steps to replace an ink cartridge before the 

 

B black 
or 

 

A color ink out light is flashing or on:

1. Make sure the printer is turned on and not printing, then 
open the printer cover.

2. Press the 

 

E load/eject button and hold it down for three 
seconds until the print head moves to the left to the black 
ink cartridge replacement position and the 

 

Ppower light 
begins flashing.

black cartridge color cartridge

Remove the yellow tape 
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3. If you need to replace only the color ink cartridge, press the 

 

E load/eject button again until the print head moves to the 
color ink cartridge replacement position.

If the print head moves to the home position instead of the 
color ink cartridge replacement position, try holding down 
the 

 

E load/eject button for three seconds until the print 
head moves to the black ink cartridge replacement 
position; then press the 

 

E load/eject button for half a 
second to move the print head to the color ink cartridge 
replacement position.

To avoid damaging the printer, never move the print head 
by hand. Don’t open the clamp or remove a cartridge 
except to replace it with a new one. Once you remove a 
cartridge, you can’t reuse it, even if it contains ink.

4. Remove the new ink cartridge from its packaging. 

5. Remove only the yellow part of the tape seal on top, as 
shown below. Don’t pull off the blue portion or try to 
remove the clear seal underneath the cartridge.

You must remove the yellow tape from the top of the 
cartridge or you will permanently damage it. Do not 
remove the clear seal from the bottom of the cartridge; ink 
will leak.

6. Pull up the ink cartridge clamp. The cartridge rises up from 
its holder.

7. Lift the cartridge out of the printer and dispose of it 
carefully. 

If ink gets on your hands, wash them thoroughly with 
soap and water. If ink gets into your eyes, flush them 
immediately with water.

8. Lower the new ink cartridge into its holder with the label 
facing up and toward the back of the printer.

9. Press down the ink cartridge clamp until it locks in place.

10. Press the 

 

E load/eject button. The print head moves to the 
color ink cartridge replacement position. If you need to 
replace the color ink cartridge, repeat steps 6 through 9. 
Then continue with step 11.

11. Press the 

 

E load/eject button again and close the printer 
cover.

The printer moves the print head and begins charging the ink 
delivery system. The 

 

P power light flashes and the printer 
makes various sounds. 

Charging takes about one minute. When it’s finished, the 

 

P 
power light stops flashing and stays on.

Never turn off the printer while the 

 

P power light is 
flashing, unless the printer hasn’t moved or made noise 
for more than 5 minutes.

Cleaning the Print Head

If your printed image is unexpectedly light or faint, or dots are 
missing from the image, you may need to clean the print head. 
This unclogs the nozzles so they can deliver ink properly.

Cleaning the print head uses ink, so clean it only if print 
quality declines. You can clean the print head in either of the 
following ways:

❏ Using the Head Cleaning utility in your printer software 
(when the printer is connected to a local port, not over a 
network)

❏ Using the printer’s control panel buttons

Always wait until your document has finished printing before 
cleaning the print head.

If you use special paper that comes with a cleaning 
sheet, don’t use the cleaning sheet with your printer; it 
may jam inside the printer.

black cartridge color cartridge

Remove the yellow tape 
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Using the Head Cleaning Utility

Follow these steps to run the Head Cleaning utility:

1. Make sure the printer is turned on but not printing, and 
both the 

 

B black and 

 

A color ink out lights are off.

2. Access the printer settings dialog box.

3. Click the Utility tab (Windows) or the Utility icon 
(Macintosh). 

4. On the Utility menu, click the Head Cleaning button.

5. Follow the instructions on the screen to clean the print 
head. Cleaning takes about 30 seconds, during which the 
printer makes some noise and the 

 

P power light flashes. 

Never turn off the printer while the 

 

P power light is 
flashing, unless the printer hasn’t moved or made noise 
for more than 5 minutes.

6. When the 

 

P power light stops flashing, run a nozzle check 
to test the results and reset the cleaning cycle.

Make sure paper is loaded in the printer and click Print 
nozzle check pattern (Windows) or Confirmation 
(Macintosh). Then click Next. The nozzle check pattern 
prints; see “Examining the Nozzle Check Pattern” on 
page 11 for details.

7. If the nozzle check pattern is filled in completely, click 
Finish.

If the pattern has any gaps, click Clean to clean the print head 
again. If you don’t see any improvement after cleaning two or 
three times, try the suggestions in “Problems and Solutions” in 
the Printer Basics book or “Troubleshooting” in the electronic 
EPSON Stylus COLOR 980 Reference Guide.

Using the Control Panel

Follow these steps to clean the print head:

1. Make sure the printer is turned on but not printing, and 
both the 

 

B black and 

 

A color ink out lights are off. 

2. Press the 

 

R cleaning button and hold it down for three 
seconds. Cleaning takes about 30 seconds, during which the 
printer makes some noise and the 

 

P power light flashes. 

Never turn off the printer while the 

 

P power light is 
flashing, unless the printer hasn’t moved or made noise 
for more than 5 minutes.

3. After the 

 

P power light stops flashing, print a page to test 
the print quality and reset the cleaning cycle.

If you’re connected directly to the printer, run a nozzle 
check. Go to step 4. 

If you’re using DOS or printing over a network, open an 
application and print a document containing black and 
color data. Then go to step 8.

4. Start an application, open a document, and access the 
printer settings dialog box. 

5. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

6. Make sure paper is loaded in the printer, click the Nozzle 
Check button, and click Next. The nozzle check pattern 
prints on the printer; see “Examining the Nozzle Check 
Pattern” on page 11 for details.

7. If the nozzle check pattern is filled in completely, click 
Finish. 

If the pattern has any gaps, click Clean to clean the print 
head again.

8. If you don’t see any improvement after cleaning two or 
three times, try the suggestions in “Problems and Solutions” 
in the Printer Basics book or “Troubleshooting” in the 
electronic EPSON Stylus COLOR 980 Reference Guide.

Examining the Nozzle Check Pattern

Examine the nozzle check pattern you print. It should look 
something like this:

Each staggered horizontal and straight vertical line should be 
complete, with no gaps in the dot pattern. If your printout 
looks okay, you’re done. If there are gaps in the lines, as shown 
below, clean the print head again; see page 10 for instructions.

gaps in pattern

gaps in pattern
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Aligning the Print Head

If your printouts contain misaligned vertical lines, you may 
need to align the print head. To use the Print Head Alignment 
utility, the printer must be connected to your computer. You 
can’t have a network connection to the printer. 

If you are using DOS or you have a network connection to the 
printer, follow the instructions in “Aligning the Print Head 
Using the Control Panel Buttons” instead.

Follow these steps:

1. Make sure the printer is turned on and letter-size paper is 
loaded.

Load paper that’s at least 8.27 inches (210 mm) wide. 
This prevents ink from spraying inside the printer and 
smudging your printouts.

For the best results, load EPSON ink jet paper in the 
printer whenever you check the print head alignment.

2. Access the printer settings dialog box.

3. Click the Utility tab (Windows) or the Utility button 
(Macintosh). You see the Utility menu.

4. Click the Print Head Alignment button.

5. Follow the instructions on the screen to print a test page 
and select the correct alignment.

You may need to repeat steps 4 and 5 more than once to align 
your print head correctly.

Aligning the Print Head Using the Control 
Panel Buttons

If you can’t use the print head alignment utility program that 
came with your printer, follow these steps to align the print 
head.

1. Make sure that letter-size or A4-size paper is loaded in the 
sheet feeder.

2. While holding down the 

 

R cleaning button, press the 

 

P power button to turn on the printer. Then release both 
buttons.

3. The 

 

S paper out light flashes for about three seconds. While 
it is flashing, press the 

 

E load/eject button.

The printer prints a sheet of instructions in English, French, 
German, Italian, Spanish, and Portuguese explaining how 
to align the print heads. Follow these instructions.

If the 

 

E load/eject button isn’t pressed while the 

 

S paper 
out light is flashing, the printer enters default-setting 
mode. If this happens, turn off the printer and repeat 
steps 2 and 3.

4. After aligning the print head, turn off the printer to exit 
print head alignment mode.

Cleaning the Printer

To keep your printer working at its best, you should clean it 
several times a year. Follow these steps:

1. Turn off the printer, unplug the power cord, and 
disconnect the printer cable.

2. Remove all the paper from the sheet feeder.

3. Clean the exterior of the printer with a soft, damp cloth. 

4. Clean ink out of the printer’s interior with a soft, damp 
cloth.

Don’t touch the gears inside the printer.

Never use alcohol or thinner for cleaning; they can 
damage the printer components and case.

Don’t use a hard or abrasive brush.

Don’t get water on the printer components and don’t 
spray lubricants or oils inside the printer.

Don’t use any cleaning sheets included with special 
media; they may jam inside the printer.

Transporting the Printer

If you move your printer some distance, you need to prepare it 
for transportation in its original box. Follow these steps:

To avoid damage, always leave the ink cartridges 
installed when transporting the printer.

Be sure to remove the tape used in step 4 after installing 
the printer in its new location. 

1. Turn on the printer and wait until the print head locks in 
the far right position. Then turn off the printer.

2. Unplug the power cord from the electrical outlet. Then 
disconnect the printer cable from the printer.
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3. Remove any paper from the printer and remove the paper 
support.

4. Open the printer cover. Secure the ink cartridge holder to 
the printer with tape as shown, then close the printer cover.

5. Push in the output tray extensions and close the tray.

6. Repack the printer and attachments in the original box 
using the protective materials that came with it. See the 
Start Here poster for details.

Be sure to keep the printer level as you transport it. If you 
notice a decline in print quality after transporting the printer, 
clean the print head (see page 10); if output is misaligned, 
align the print head (see page 12). 

Related Documentation

TM-SC980 EPSON Stylus COLOR 980 Service 
Manual

PL-SC980 EPSON Stylus COLOR 980 Parts Price 
List

CPD-10632 EPSON Stylus COLOR 980 Printer 
Basics

CPD-10633 EPSON Stylus COLOR 980 Start Here

EPSON Stylus COLOR 980 Reference 
Guide (HTML format; to view it, you 
need a browser, such as Microsoft® 
Internet Explorer 3.0 or later or Netscape 
Navigator® 3.0 or later)

EPSON Stylus COLOR 980 Fix-it FlixSM

(Flash movies on the printer software CD-
ROM that show the user how to load 
paper and envelopes, change ink 
cartridges, clean the print head using both 
software and control panel buttons, and 
print on both sides of the paper [duplex 
printing].)
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